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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name
OMRON 1610-E1 Model CK3E-1[110 CK3E-series Programmable
Multi-Axis Controller Hardware
User’s Manual
OMRON 0036-E2 Model CK3M-CPU1[1 | Programmable Multi-Axis Controller
Hardware User’s Manual
OMRON W580-E1 Model Industrial PC Platform NY-series IPC
NY512-A6001XX21391 | Programmable Multi-Axis Controller
X Industrial Box PC Hardware User’s
Manual
OMRON I1574-E1 Model G3AX-MX2-ECT | Inverter EtherCAT® Communication
Model G3AX-RX-ECT | Unit User’'s Manual
DT 0014-E - Power PMAC User’s Manual
DT 0015-E - Power PMAC Software Reference
Manual
DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and I/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESlI files into the Power PMAC IDE, to easily allocate
slave process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) 1t is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of April 2019.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

f C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

/A WARNING

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON Multifunctional
Compact Inverter MX2 Series EtherCAT Communications Unit model 3G3AX-MX2-ECT
(hereafter referred to as the Slave) using OMRON Programmable Multi-Axis Controller model
CK3E-OOOMO0O/ CK3M-CPUL11/ NY510-AOOMO (hereafter referred to as the Controller)
and EtherCAT, as well as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices

The applicable devices are as follows:

Manufacturer Name Model

OMRON Programmable Multi-Axis Model CK3E-OJOO0O
Controller

OMRON Programmable Multi-Axis Model CK3M-CPU11
Controller

OMRON Programmable Multi-Axis Model NY510-ACO0O
Controller Industrial Box PC

OMRON Multi-function Compact Inverter Model 3G3MX2-ALULLILI-V1

OMRON EtherCAT Communications Unit Model 3G3AX-MX2-ECT

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration

The hardware components to reproduce the connection procedures in this document are as
follows:

Model 3G3MX2-A2004-V1
Model NY5100-AO00O0O Model 3G3AX-MX2-ECT

Power PMAC IDE

EtherCAT
communications

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model NY510-AC OO Ver.2.5 o later
Controller
OMRON Multi-function Compact Model 3G3Mx2-A2004-v1 | Ver 20
OMRON CIErCAT Communications | yodel 3G3AX-MX2-ECT | Ver. 1.1
OMRON Ethernet cable (with industrial Model XS5W-T421-C0MO-K
Ethernet connector)
DT Power PMAC IDE h Ver. 4.2.1.19

El Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information

This document describes model NY51-ACC O as an example. The same procedures can
apply to model CK3E-OO OO O/CK3M-CPU11.
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6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller is set to factory default.

I 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting

the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup

v

6.2.1 Creation of a New Project

v

6.2.2 Initial Settings of the Controller

v

6.3 Installation of ESI Files

v

6.4 EtherCAT Communications Setup

v

6.4.1 Communications Setup for the EtherCAT Master

v

6.4.2 Distributed Clock Setup

v

6.4.3 PDO Map Settings

v

6.4.4 Creation of an EtherCAT Network Configuration
File

v

6.5 Controller Settings

v

6.5.1 EtherCAT Communications Check

v

6.5.2 Writing the User Program

v

6.5.3 Project Data Transfer

Prepare the Controller settings.

Install the ESI file for the Slave into
Power PMAC IDE.

Set up EtherCAT communications.

Set up the Controller.

11



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.

6.2.1. Creation of a New Project

1 Turn on the power to the
Controller.

2 Start Power PMAC IDE.

* |f the dialog for confirming [d
access rights appears upon FIDWTBPEFME
start-up, select starting of '

Power PMAC IDE.

3 The Communication screen
appears. Specify the IP
address of the destination

Controller and click Connect. = P Aldress 199 168.0 300
Part 22
Protocol
* The IP address of the User root
. Pazzward 990999
Controller is set to SelectDevice AtStartup True

“192.168.0.200" by default.
* |If necessary, change the
Windows IP address to IP Address

Set IP Address
“192.168.0.X".

’ Cionnect ] ’ Lazt Sezzion IP ] [ Mo Device l

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

12



4 Power PMAC IDE starts, and is

online to the Controller.

[ -
L R e R

SRR ERRE Y T AR - - ERoti s » - Pl S0 el - @areE-,
B st F ity | Dt @i Fpes D Ty | S tyn ket S .

— s precers >
Pt PMAC Corhiguration Waorkdlow ]
@ PowerPMACIDE [ e b e |

yr

5 From the File menu, select

New then Project.

@ Powervaces2110 [

File | Edit View Debug Tools DeltaTau EtherCAT  Window  Help

New '3 Project... Crl+Shift+N
Open Y File Cirl+N Je
Close "
Position
Close Solution
Position
Upload Project From PowerPMAC
W Save Selected Items Ctrl+S
Save Output As...
¥ Save All Ctrl+Shift+S
Export 3
Import 3
B Page Setup...
= Print... Ctrl+P
Recent Files 3
Recent Projects and Solutions 3
B Exit Alt+F4
G Enter aproject name and
location, and select OK. New Pt
¥ Recent Sort by Defaul - P
il _Q e S Types PowePMAC
PrwerPMAL g A b PermerPMAL prejest '
PowerPMAC Solution PuaPMAL with FtharCAT [Asontic] PowaPhAC
Pouserftick LY Powe BT
Dame PowerFMACS
lotsten e - [momse |
Sahaion name BrwerBhACS v Create directoryffor solution
Lok || conce
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary
data in advance.

i owerPMACS - Power 2120 (I
In the Terminal tab page, type the @ feeic-oemncbeiais

File Edit View Project Build Debug Tools DeltaTau E

$$$*** command to reset the "OlB-u-uMPR|XEa|?-C -k

& StartPage ¥ Communication Setup | 5=] Terminal 4 Position

Controller to factory default. Wetch Window
C Query
Sys.ServoCount 2764277 -
Sys.ServoPeriod 1
ECAT[O].Enable 0
Motor[1].ServoOut a
Motor[11.PosSf 1
Terminal

2 Select System — CPU — System | =er EXT‘W | T
. . G| o~ a|f -
n the SOIUtlon EXplorer Search Solution Explorer (Ctri+:) P~
1 PowerPMACS =
4 [ System

4 [ CPU
3 Hardware
[ EtherCAT
[ Motors
[J Coordinate Systems
b 3@ Encoder
b [ C Language
b 3 Configuration
b [ Documentation

b [ Log -

Solution Explorer

3 Select Global Clock.

CPU Settings

Global Clock Commonly Used
Structure Elements

Advanced View |

14



4 Specify Servo Frequency.

Select the Servo Frequency
setting from 4 kHz, 2 kHz, or
1 kHz.

Global Clock Settings

Phase Frequency 1

Servo Frequency

1.000 -

kHz

kHz

5 Click the Accept button.

New clock
Items )
settings Value

Servo Period (msec) 1.000 1.000

PowerPMAC “

-

EtherCAT option detected and no Master Gate
detected, using internal clock by setting

. ays. CPUTimerIntr = 1. For EtherCAT the
ServoPeriod must be multiple of 62.5 usec. On
Accepting the clock issue save and type $55 in

s

-

= Commeonly Used Structure Elements

Accept

6 If you have changed the servo
frequency setting, type the save
command in the Terminal tab

page of Power PMAC IDE.
When complete, the “Save

Complete” message appears in

the Terminal tab page.

Terminal

AVITIY 1O T IO L OYTIEITIY 11PERS U 1193511

Saving To Flash: Mounting the flash

Sawving To Flash: Finished SAVING to flash

Save Completed

7 Click Delta Tau —

Communication Setup on the
toolbar to display the Device

Properties dialog box.

@ FPowerPMACS - PowerBMAC IDE 4.2.1.19 _

File Edit View

2 bbb |
| & S

Project Build Debug Tools

Delta Tau

- | Debug

EtherCAT

-~ Am

Command/Qui
Sys.servocount
q| Lt |
4 Device -
TP Address 192.168.0.200
Fort £
ECAT[0].Enablg] Protocol SSH
User root -
Sys.ServoPeriogi 7p—1ao |E
Set IP Add
Sys.ServoDeltaTl| ® ress
Sys.FltrServoTi
Sys.MaxServoTi — e
Qe MinQarnmnTima 1 A7INANANANNANNNNE
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8 In the Device Properties dialog
box, select No Device for IP
Address, then click the Apply
button.

This operation sets the Controller
to the offline state.

@ Device Properties

Test

Apply

4 Device
IP Address
Part
Protocal
zer

IP Address
Set IP Address

Ho Device

55H

i

14 |.m

»

9 Restart the Controller.

The servo frequency that has
been set is reflected.

1

9) Wait until the startup process of
the Controller is complete. Then
click Delta Tau —
Communication Setup on the
toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the Controller

to the online state.

@ Device Proparties

Test

S
| Apply

IP Addreszz
Part
Protocal
|Jzer

IP Address
Set IP Address

192.163.0.200

55H

l.m

—

16



I 6.3. Installation of ESI Files

Install the ESI file for the Slave intoPower PMAC IDE.

m Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 From the EtherCAT menu of Power @ PowerPMACS - PowerPMAC IDE 4.2.1.19

File Edit View Project Build Debug Tools Delta Tal
PMAC IDE, select ESI Manager. G-t ad| LA

Watch Window

Command /Query Response Position

Sys.ServoCount 577552

ECAT[0].Enable=1

FeATIAT Fankia A

2 Confirm that Omron i} _ §
= ESI Manager P @Elﬂ

3G3AX-MX2-ECT.xml is registered in |
ESI Files

the ESI f|le I|St Of ESI Manager Select an ESI file which should be deleted or exported or add new ESI files.

& Delta Tau Data Systems, Inc. —i

IZX | Omren Corporation

If it is not yet registered, click Add File Omron 3G3AX-MX2-ECT xmi

Omron 3EIAY-BY-FCT wml

and register Omron o ot £ e 1
3G3AX-MX2-ECTXmI Number of devices: 360

. Pecent Places

B videcs

8 Computer
Bl vocal Diek {0
- Local Disk {0

= Peminable Disk |

Wi Metwork

File paene: v | Supported Fles {"ami o)

Open Caneel

Add File Add Folder Delete Export Close
= fcled F4] File i i ==
@Oal v Computes + Removable Disk () + MG-ETC w [ 4 ] Search Mi-ETC 5
e e = = - -

| L — -~ @ |

Favante:

L Desitop I = Oenron, 1 IGAAN- M EC T aml un 11 PM L L I

& Downloads

3 Click Close to close the ESI Manager
page.

I 6.4. EtherCAT Communications Setup

Set up EtherCAT communications.

|h Precautions for Correct Use

17



Before taking the following steps, make sure that the devices are connected via an Ethernet

cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

1 Connect the Controller with slave
devices using an Ethernet cable.
* Refer to the manuals for slave
devices to configure them.
2 Select System — EtherCAT —
Master0 (Deactivated) in the rowerriAcs
Solution Explorer. R
-3 Hardware
4 5 FtherCAT
i - ey e —
3 Coordinate Systems
I [ Encoder
P [ Clanguage
b [ Cenfiguration
B [ Decumentation
b [d Log
b 3 PMAC Script Language
3 In the Master tab page, specify a e

Master | Topology View

Slaves comnected to remete system
1P Addvess 192.168. 0 .20
Port 0

Master-Instance

Metverieies: | | Slaves 0

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

18



@ o-a|F -
Search Solution Explorer (Ctrl+;)

1 PowerPMACS

4 Select System — EtherCAT in the
Solution Explorer and right-click

on MasterO (Deactivated), then 4 ;jgﬂce;ﬂu
select Scan EtherCAT Network. [ Hardware

4 [ EtherCAT

Configuration Mode

1 Motors

£3 Coordina Diagnosis Mode

b [J Encoder Scan EtherCAT Metwork I
4 CL

— ar?guag.e Append Slave
b [ Configuratio
b [ Documentat Paste Slave Ctrl+V
b [dLog Import Slaves from ENI
b [J PMAC Script

Export ENI File

Load Mapping to PowerPMAC
Load Mapping to PowerPMAC From ENI

SE3rch Soluticn Explorer [LIr+;)

] PowerPMACE
4 [T Systemn
B [3 CRPU
1 Hardware
4 |7 EtherCAT
4 [ﬁ] Master) (Deactivated)
&5 Slave 1001 [3G3AX-MX2-ECT] (1001)
1 Motors
[ Coordinate Systems
P 1 Encoder
P [ Clanguage
P [ Configuration

B T Marimnan Fatinm

5 Make sure that the slave is
displayed in the Solution Explorer.

6.4.2. Distributed Clock Setup

1 In the Solution Explorer, select
the target slave to display the
Advanced Options tab page.

e
Hie-Gp-Sale CpSate- g
Boshto Pre- i o

Chack tens umbas

gttt

Henthicaton Chackag Ladbor Mod

Chack Kencticason ® e 10 £t}
e Change

Lo et Madham Site
Disssbe LR vt S yten]

e Size Iees]
f— Watchag
¢ St Msbpber (Rag G800 E g
T St POR Wanibobes [P Sty 3000 7 0106000 )
o St M et (g Exkt) 0000 3 (4200000 )
Drenbaeed Clachs SohtionExplss
Pubmatial Refwrems ¢ Chish
Phesrenbe 1 | Soersc 1 ot Mok CONID
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2 Inthe Advanced Options tab Stave 1001 3 e-£CT] aoor) =

page, clear the Potential Lizssudiloy
| General " PDO Mapping " ‘u’ariables| Advanced Options |Ir1it Commands " CoE Object-Dictiona
Reference Clock check box.

Startup Checking Timeouts
Check Vendor ID SDO Access:
Check Product Code

[[] Check Revisien Mumber

Init->Pre-Op/Ini
Pre-Op-»5afe-0
Back to Pre-Op,

[[] Check Serial Mumber

Op-»5afe-Om
Identification Checking Mailbox Made
[[] Check Identification @ Cyclic
118 [ Bec | Hex | Write to EEPROM State Chanc
Select Local Address i
0:0012 Dec | Hex |
Process Data Mode Overwrite Mail
[C] Disable LRW [[] Output Size
[C] Input Size:
Overwrite Watchdog
Set Multiplier (Reg.: 0x400): 2488 =
Set PDI Watchdeg (Reg.: 0x410): 1000 = (100,000 ms)
Set SM Watchdog (Reg.: 0x420): 10000 - (1000.000 ms)

Distributed Clocks
{[T]i Potential Reference Clock

|§ Additional Information

Multifunctional Compact Inverter MX2 Series EtherCAT Communications Unit model
3G3AX-MX2-ECT does not support DC mode.
Disable the reference clock by taking the steps shown above.

20



6.4.3. PDO Map Settings

1 In the Solution Explorer, select
the target slave and display the
PDO Mapping tab page.

b | isgwnnced Optons | Ine Commaads. | Gl Gbist-Dictianany | fync biats

srmt PO Wsgperg eruded sy DBIL 0B~

g

gt

FETE reoe PO Magoing ievciuded By S

1
@ v 408 [JOMNENAG-EET] (081
|

oax

3 Ceandinme Systerre,

=T
B (3 PMAC Seript Language

2 Check the Inputs field to make

Inputs {
sure that onIy the 258th 257th transmit PDO Mapping (excuded by 0x1B01)  Ox1BOQ -~
transmit PDO Mapping Mame Index Eit Length
0x1BO01 check box is selected. cttuemond 04400 e

vl velocity demand 0x6043:00 16 |
* If you want to use .other data, 255th transmit PDO Mapping B0
clear the currently displayed — — ==
check boxes and select other Status 0X5100:00 1
desired check boxes. Cutput frequency m | 0x5110:00 16
|:| 512th transmit PDO Mapping 0x1EFF
Mame Index Eit Length
3 Check the Outputs field to make
sure that only the 258th receive
PDO Mapping 0x1701 check Outputs
box is selected. 257th receive PDO Mapping [excluded by 0x1701) 01700
Mame Index Bit Length
* |f you want to use other data, contrefword frenann e
clear the currently displayed vl target velocity 0x504.2:00 16
check boxes and select other 258th receive PDND Mapping 01701
desired check boxes. MName Index Bit Length
Command 0x5000:00 16
Frequency reference  0x5010:00 1a
|:| 1st receive PDO Mapping 0x1&00

21




6.4.4. Creation of an EtherCAT Network Configuration File

1 Select System — EtherCAT in

the Solution Explorer and
right-click on Master0

(Deactivated), then select Load

Mapping to PowerPMAC.

W o-a|”r =

Search Selution Explorer (Ctrl+;)

1 PowerPMACS
4 [ System

b 3 CPU
[ Hardware
4 [ EtherCAT

Configuration Mode 01 BG3AX-MX2-ECT] |
Diagnosis Mode
Scan EtherCAT Metwork stems
Append Slave

Paste Slave Crl+V

Import Slaves from ENI

2 An eni.xml file is added under
the Configuration directory in

the Solution Explorer.

Export EMI File
|age
| Load Mapping to PowerPMAC
oad Mapping to Powerl rom
Activate EtherCAT
LI
Search Solution Explorer (Ctrl+;) P~

| PowerPMACS
4 [ System
b3 CPU

1 Hardware
4 | =7 EtherCAT
4 E'l Masterd) (Deactivated)

& Slave 1001 [3G3AX-MX2-ECT] (1001)

d Motors
[ Coordinate Systems

= Encoder
I [ CLanguage
4 |7 Configuration

cfg
Y pp_custom_savetpl

3 An ECATMap.pmh file is added

under the PMAC Script

Language/Global Includes

directory in the Solution
Explorer.

R b L
@ pp_save.cfy
E pp_startup td
[ systemsetup.cfg
1 Documentation
[ Log
| PMAC Script Language
4 [ Global Includes

= .
B === g o =

[l ECATMap.pm|
e Rt
B[] Libraries
P[4 Motien Programs hd

A

[

4
Solution Explorer FeEERNTE

I 6.5. Controller Settings

22



6.5.1. EtherCAT Communications Check
Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal tab page, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

PowerPMAC Messages Terminal LGy Wl Output

2 In the Terminal tab page or Watch
Window, make sure that the

Watch Window

Command/Query Response
ECAT[0].Enable value turns to 1.

Sys.ServoCount 7712293
* The OP mode is entered and EElEEn 1
EtherCAT communications are ecat[0] MasterState '8
established. Motor{1].ActPos 2

3 After making sure that correct
communications are available, run
the ECAT[0].Enable=0 command
from the Terminal tab page to stop
EtherCAT communications.

|ECAT[D].EnabIe =0

PowerPMAC Messages MEMIGEIN Terminal Output

4 In the Terminal tab page or Watch

| Watch Window

Window, make sure that the ol SR
ECAT[O].Enable value turns to O.
Sys.ServaCount 7778040
ecat[0].Enable 0
ecat[0].MasterState 2
Motor[1].ActPos 2

23



6.5.2. Writing the User Program
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s

Manual and Power PMAC Software

Reference Manual for details.

1 In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs — plcl.plc.

1 Hardware
B [ EtherCAT

[ Maotaors

[ Coordinate Systems
I [ Encoder
[J CLlanguage
[ Configuration
d Documentation
[d Log
|Zr PMAC Script Language
I [ Global Includes

4 Einematic Routines
I+ [ Libraries
B [ Metion Programs
4 [ Z PLC Programs

[N plcl.plc

A ¥ ¥ V¥

In the programming area of the
plcl.plc tab page, write a
program as shown on the right.

This sample program rotates
the motor by switching the
frequency and rotation direction
of the 3G3AX-MX2-ECT motor
with the interval of 3 seconds.

* In this example, PDO
mapping is assumed to be the
default setting. If you want to
change PDO mapping, rewrite

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable=1;
if (P1001 > 2000){

P1001=0;

}
P1001 = P1001+100;
if(P1002==0){
P1002=$0081;
}else if(P1002==$0081){
P1002=$0082;
telse{
P1002=$0081;

}

Slave_0_ 5010 0 Frequencyreferenc =P1001;
Slave_0 5000_0 Command = P1002;
P1000=Sys.Time+(P1001/500)+3;
while(P1000>Sys.Time){};

close

the “Slave_0...."” description.

24




3 Setting the start of the user
program

In the Solution Explorer pane,
open Project name —
Configuration —
pp_disable.txt.

b [ EtherCAT
1 Motors
[ Coordinate Systermns
P [ Encoder
b [ Clanguage
4 | Configuration
[ ECATCaonfig.cfg
=] enixml
[ pp_customn_save.cfg
|| pp_custom_sa\re.tlcll

=| pp_disable.bd
= pp_inc_disable.tx't’
pp_inc_startup.bxt
pp_save.cfg
pp_startup.bd
systermnsetup.cfg
I [d Documentation

4 i Loa

3 Ly 5 fu

4 In the programming area of the
pp_disable.txt tab page, add
the program shown on the right

enable plc 1;

to the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

6.5.3. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is

operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the

EtherCAT network configuration.
Before you transfer project data, make sure that the slave settings will not

adversely affect the devices.
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1 In the Terminal tab page or Watch

Window, make sure that the
ECATI[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal tab page to
stop EtherCAT communications.

Watch Window
Command /Query Response

Sys.ServoCount 13312872

ECAT[0].Enable | 0

Downloading a project

Right-click the project name in the
Solution Explorer pane on the
upper right of the IDE screen, and
select Build and Download All
Programs to run the build and
download.

* The transferred project is not yet
saved to the Controller at this
stage.

If you turn OFF the power to the
Controller, the transferred project
will be discarded.

Solution Explorer * 1 x
@ - p =
Search Solution Explorer (¢ O ~

PowerPMACS

& Build 1 System
Rebuild 1 C Language
Clean __1 Configuration

1 Documentation
New Solution Explorer View T Log

| Build and Download All Programs L1 PMAC Script Language

Add Macro Project
Export Project with IP Protection...
Export Project Template...

¥ cut Chrl+X
Unload Project
¢* Open Folder in File Explorer

& Properties Alt+Enter
pEeTa——— |

Make sure that there are no
errors in the Output Window.

* |f the transfer fails, check details
of the error in the Output Window.
If the error is a program error, you
must review the program.

If the error is related to EtherCAT
settings, return to 6.4. EtherCAT
Communications Setup and
check whether there are any
incorrect settings.

26



4 The program starts running

when it has been downloaded -
Terminal

successfully.

EtherCAT communications are
in the OP state.

Make sure that the motor
rotates.

enable plc 'I|

* |f the motor does not rotate,
check that the ECAT[0].Enable
value is 1 in the Terminal tab
page or Watch Window.

If the value is 0, run the
following command from the
Terminal tab page.

enable plc 1

After you have confirmed an
appropriate operation, save the

project to the Controller. Vi el
Available disk spac
Required disk sp

Run the save command from Saving To Flash: Syncing files to flash

the Terminal tab page. Saving To Flash: Mounting the flash

Saving To Flash: Finished SAVING to flash
* The save command stores the

downloaded project in the Selslleile s

Controller. This operation saves —

the settings to be executed
automatically when the power to
the Controller is turned on.
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7. Appendix

Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to

reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

Create a Configuration File to save
parameters you have changed.

Right-click Configuration in the Solution
Explorer pane, and select Generate
Config File.

A Configuration File is added to
Configuration.

L [R3ED-15N01L-ECT] (1001) Solution Explorer T X

| » [+

@ o-a|F=

Search Solution Explorer (Ctrl+;)

[} ECATConfig.cfg
2] eniml
[ pp_custem save.cfg Mew Solution Explorer View

Scopeto This

[ pp_custom_save.tpl

= P
=) pp_disablebxt

=] pp.inc_disablett
2] pp_inc_startup txt

Properties

Upload Config Files

1 Re8D-1SN
b (3 System
b [ Clanguage
| |4 W Configuration —— [NENE

Alt+Enter

D) pp_savechq

Generate Config File
=] pp_startup.bet

[ systemsetup.cfg
b 4 Documentstion
b [d Log
P 3 PMAC Seript Language

Enter a file name in the textbox, then click
the OK button.

==

.
@ pp_dificfg

Pleaze type a name for the Config File.

|
Lo |

[ Cancel ]

Right-click on the Configuration File, and
from the menu, select Check To
Download Config File to include it in files
to be downloaded.

[ pp_save.cfg
=] pp_startup.bd
statail .o
Ooe Open
b [ Dt Open With...
P [3 L
4 =P <> View Code

4 [ Scope to This

New Solution Explorer View

Exclude From Project
Solution Ex
Ctrl+C

Ol Copy

R88D-1SN Rename

as O | I Check To Download Config File

B FileEncl & properties Alt+Enter
Enable Erluypr.run ™o

E Misc
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3 Saving a Project

In the File menu, run Save All to save the
project on the computer.

File

801N - Powerptac 10 4.2:1.19 (N

Edit View Project Build Debug Tools DeltaTau Et
MNew L -| Debug
Open ¥ 1 Position [
1
oo
Close Project

Upload Project From PowerPMAC
Save RBED-15N.cfg

save RBED-15M.cfg As...

Save All

Export

Impont

Page Setup..

Print...

Recent Projects and Solutions

Exit

Ctrl«5

Cirl+Shift«5

CtrlP

Alt+Fd

Moter[1].Idata[11]=1176256512
Motor[1].Idata[12]=1188741128
Motor[1].Idata[13]=@
Motor[1].Idata[14]=2
Motor[1].Idatal15]=08
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal tab page, type the
$$$*** command to reset the
Controller settings to factory
default.

Terminal

PowerPMAC Messages [EUgIGED

Terminal Output

3 In the File menu, click Open —
Project/Solution to load the
project that you saved.

@ PowerPMACIDE42119 £ 1p: 192168.0.200 Type: MOTION CO|

File | Edit View Debug Tools DeltaTau EtherCAT  Window Help
oy
Open * | 99 Project/Sclution... Ctrl+Shift+0
< S File.. Ctrl+0
Close Project
Upload Project From PowerPMAC
Save Selected rems Ctrl+5
Save Selected ltems As...
W¥ Save Al Ctrl+Shift+S
Export 3
Import »
Page Setup...
Print... Ctrl+P
Recent Projects and Solutions »

Exit Alt+F4

4 Right-click Configuration in the
Solution Explorer pane, and
select Download Config Files to

download the file to the Controller.

L =

— T,

+ @ o-a|p -
-

Search Solution Explorer (Ctrl+;) P~

1 R88D-1SN
P 3 System
P [ Clanguage

|| 4 B Cofiguation |

O Add C
3 Scope to This

I MNew Selution Explorer View
Ry 4 Properties
 iconioti

i Downlead Config Files

Alt+Enter

+ [ R8ED-1SN.cfg
[ systemsetup.cfg
I+ [ Documentation
P [d Leg
P 3 PMAC Script Language

Solution Explorer
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5 Right-click the project name in the | = cooe ~ 7 x

Solution Explorer pane, and
select Build and Download All
Programs to run the build and
download.

When the download process is
complete, make sure that there
are no errors in the Output
Window.

+ T,
T @ o-alr -
-
—A8 Search Solution Explorer (Ctrl+;) P~
l. T .
) .

b L3 Sys kil Build
b Emcl Rebuild
4 [ Z Col Clean

0=

Mew Solution Explorer View

Build and Download All Pregrams

0O

%1 Add Macro Project

g Export Project with IP Protection...
] Export Project Template...

2 ¥ cut Chrl+X
B Unload Project

b [3 Dod (54 Open Folder in File Explorer

Properties Alt+Enter
R
Selution Explorer

6 Stopping a program

If a program is running, execute
the following command from the
Terminal tab page to stop the
program.

disable plc 1

ECAT[0].Enable=0

E

|disable ple 1

PowerPMAC Messages MEINIGEN Terminal Output

Terminal

|ECAT[D].EnabIe= 0

PowerPMAC Messages MIEIUILEIN Terminal Output
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7 Saving the downloaded settings

and programs

After the download process is
complete and you make sure that
there are no errors in the Output
Window, run the save command
from the Terminal tab page.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal

Cat 192.16

|sava|
PowerPMAC Messages JIEUUIGEIN Terminal Output

Restarting after download

Run the following command from
the Terminal tab page to restart
the Controller with the
downloaded project.

$$$

Terminal

Sawving To Flash: Mounting the flash

Saving To Flash: Finizhed SAVING to flash

Save Completed

|sss|

PowerPMAC Messages IIEGUIGEN Terminal Output
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8. Appendix

Troubleshooting

I 8.1. Factors Causing EtherCAT Communications To Be Unavailable, and

Corrective Actions

Description

Factor

Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECATI[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is set to a
value other than 0.

Check the ECATIO].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from Diagnosis Mode of Power PMAC IDE.

Right-click on Master0 (Deactivated) under EtherCAT in the Solution Explorer, then select
Diagnosis Mode to open the Diagnosis Mode page

4 |7 System
g CPU

1 Hardware
4 | =7 EtherCAT

Configuration Mode

B sla

P [ Motors I Diagnosis Mode I
(3 Coordinat Scan EtherCAT Metwork
I+ [ Encoder
[ Clanguage Append Slave
b [ Configuratiol Paste Slave Ctrl+V
I [ Documentati
b Ca Log Import Slaves from ENI
4 [ PMAC Script Export ENI File
b [ Global Ing Load Mapping to PowerPMAC
- K.lner'r?atlc Load Mapping to PowerPMAC From ENI
[+ [ Libraries
b £ Motion Py Activate EtherCAT
= 'F_"LC ?’1':'9' Edit Tepology

You can check the status of the slaves in the Diagnosis Mode page.

Master0 (Diagnosis) & X
Device Editor

‘ General |Process Data Image || Watch list || Performance || Variables || CoE ohject-[:-ictionary" History|

State Machine

Current State Op
Requested State Op
Init ootstrap
Change State Pre-Op Safe-Op
op
Information Frame Counter
MNumber of found slaves 1 Sent frames 1091052
Mumber of slaves in configuration 1 Lost frames 0
Mumber of DC slaves 1 Cyclic frames 1080854
DC in-sync Yes Acyclic frames 10198
Topology Ok Yes Clear counters
Link Connected Yes
Slaves in Master State Yes
Networks: 1 | Slaves: 1 State: @ & | Mode: DIAGNOSIS
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8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status

Motor Status Coordinate Status

Global Status

Description

Status

AbortAll False

BufSizeErr
ConfigLoadErr
Default
FileConfigErr
FlashSizeErr

False
False
False
False
False

| MACRO Status

Description
HWChangeErr
MoClocks
ProjectLoadErr
PwrOnFault
WDTFault

Status
False
False
False
False
MoFault

35



M Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Status * 0 X

Coordinate Status Global Status MACRC Status

Motor 1 = ® Motor not activated

Description Status Description Status
False I2tFault False
AmpFault False InPos False
AmpWarn False InterlockStop False
AuxFault False LimitStop False
BIDir Plus MinusLimit False
BlockRequest False PhaseFound False
ClosedLoop False PlusLimit False
Csolve False SoftLimit False
DacLimit False SoftLimitDir Plus
DesVelZero False SoftMinusLimit False
EnclLoss False SoftPlusLimit False
FeFatal False SpindleMotor False
FeWwarn False TraceCount 0
GantryHomed False TriggerMove False
HomeComplete False TriggerMotFound False
HomelnProgress False TriggerSpeedSel MaxSpeed

B Coordinate Status
You can check deviation errors, limit errors and other states of the coordinate system.
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Status * B8
Meotor Status Coordinate Status | Global Status | MACRO Status
Coordinate System 0 =
Description Status Description Status
AddedDwellDis LinToPvtBuf False
AmpEna False LockAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookAheadFlush False
Bloclkactive False LookAheadLookBack False
BlockRequest False LookAheadReCalc False
BufferWarn 0 LookAheadStop False
CC3Active False LookAheadWrap False
CCAddedArc False MinusLimit False
CCMode Off MoveMode LineCircle
CCMoveType Dwvell PlusLimit False
CCOffReq False ProgActive False
ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegHaltReq False
EnclLoss False SegMove Off
EndDelayActive False SegMovehccel False
ErrorStatus MNoError SegMoveDecel False
FeedHold Off SegStopReq False
FeFatal False SharpCornerStop False
FeWarn False SoftMinusLimit False
HomeComplete False SoftPlusLimit False
HomelnProgress False TimerEnabled False
[2EFault False TimersEnabled False
InPos False TriggerMove False
InterlockStop False TriggerMNotFound False
LimitStop False
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9. Appendix ECAT]Ii] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT
controllers.

Element name Description Change
ECATIi].Enable Enabling the EtherCAT 0: Disable, 1: Enable
network (2 and 3 are not supported.)
ECATIi].LPIO[K] Elements of low priority Not supported
I/O module
ECAT]Ii].Slave[j] Slave elements Not supported
ECAT[i].Error Error code of enabling $ 9811000C: Invalid network
EtherCAT network configuration
$ 9811002E: Disconnected network
connection
ECATIi].LinkUp Status data structure Not supported

ECATI[i].LPDomainOutputState | elements
ECATI[i].LPDomainState
ECAT[i].LPRxTime

ECATI[i].LPTxTime

ECATI[i].MasterStat

ECAT[i]. RTDomainOutputState

ECATI[i]. RTDomainState
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